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1. Deployment Topology

Installing  IBM® Connections in a network deployment to achieve optimum scaling, load balancing, and failover.

A network deployment can consist of a single server with all applications installed, or two or more sets of servers that are grouped 
to share the workload. You must also configure an additional system with WebSphere® Application Server Network Deployment 
Manager, which enables you to build, manage, and tune the clustered servers. 

A network deployment provides the administrator with a central management facility, and it ensures that users have constant access 
to data. It balances the workload between servers, improves server performance, and facilitates the maintenance of performance 
when the number of users increases. The added reliability also requires a larger number of systems and the experienced 
administrative personnel who can manage them. 

Standard Enterprise Network Deployment Architecture

Figure 1 shows the enterprise-level network deployment of IBM Connections without any additional complexity. This topology shows 
a two-node cluster of IBM Connections, in which the LDAP and database servers communicate with the cell controlled by the 
Deployment Manager. The Tivoli Directory Integrator server sits between the database and LDAP, maintaining synchronization 
between both.

IBM Connections is installed on the Deployment Manager machine and from there is pushed out to the nodes in the cell, 
node01Node and node02Node. The shared data store is a shared space accessible from all nodes in the configuration and the 
Deployment Manager. In this case the shared space is mounted on the Deployment Manager machine and shared with both nodes, 
at the same location on those machines.

Sitting in front of the entire configuration is the Web server, from which the end user accesses IBM Connections. 

 
Figure 1

In this Scenario and in the above Topology diagram the following apply:
� Cognos/Metric is not installed - Cognos install/configuration is covered in a separate document.
� IBM Connections Content Manager (Filenet) is not installed - Filenet install/configuration is covered in a separate document.
� the WAS Deployment Manager and the IHS server both co-exist on the same physical machine, but they are depicted (in the 

diagram) as existing on different machines. This was done to help simplify understanding of this deployment - note the 
hostname is the same for both.

� The Domino Mailin server is not integrated with the MS-AD2008 LDAP so that users are not automatically created as needed on 
the Domino mail server; instead Domino mailin users were created manually (as needed) and the mapping between IC4 and 
Domino users was based on the users email address. This is not typically how customers would configure Notifications and 
Domino mail integration.

When installing IBM Connections there are three deployment options to choose from ie small, medium and large. This deployment 
uses the Medium topology; see Deployment options for more details.

Topology: Medium deployment
Install a subset of applications in separate clusters. IBM Connections provides three predefined cluster names shared 
among all 12 applications. Use this option to distribute applications according to your usage expectations. For instance, you 
might anticipate higher loads for the Profiles application and install it in its own cluster, while other applications could be 
installed in a different cluster. This option allows you to maximize the use of available hardware and system resources to 
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suit your needs.

2. IBM Connections 4.5 System Requirements

For IBM Connections V4.5 System requirements see the product documentation:  http://www-01.ibm.com/support/docview.wss?
uid=swg27037782 

Systems specification used in this deployment
Machine Hostname Applications Version OS/version RAM / CPU / HDD

dm&ihs.spnego.company.com   WAS Deployment Manager
  IBM HTTP Server (IHS)

  WAS v8.0.0.5 (64bit)
  IHS  v8.0.0.5 (64bit)

node1.spnego.company.com   Node1 (WAS Application Server)   WAS  v8.0.0.5 
node2.spnego.company.com   Node2 (WAS Application Server)   WAS  v8.0.0.5

db2.spnego.company.com   DB2
  Tivoli Directory Integrator (TDI)

  DB2 v10.1
  TDI v7.1+FP5

RedHat 6 (64bit) 
Enterprise

8GB / 2CPUs / 
80GB

msad2008.spnego.company.com   MS Active Directory 2008   '2008 Win2008 R2 EE 
Server

domino.company.com   Domino Mail-in server   Domino 8.5.3 Win2008 R2 EE 
Server

4GB / 2CPUs  / 
40GB

� All of the above systems are Virtual Machines (VM) running on VMware vSphere V5.0

When installing Connections (in this scenario) we refer to a fictitious user called "AdminFromLDAP"  - this user must meet the 
following criteria:
•is a valid user from the LDAP branch
•is populated to the profiles database (PEOPLEDB) when running the dbPopulation wizard
•is granted Admin access to the DM so that this user can login to the WAS console and can administrate all aspects of Connections
•is selected as the Connections administrator when running the Connections Install wizard

Note: Where possible we will use the default setting throughout this document especially for paths.

Before Installing IBM Connections you must apply the following:

i) Linux RedHat 6 (64bit) OS essential patches:  see the IBM Connections InfoCenter for details: 
http://www-10.lotus.com/ldd/lcwiki.nsf/xpDocViewer.xsp?
lookupName=IBM+Connections+4.5+documentation#action=openDocument&res_title=Linux_libraries_ic45&content=pdcontent 

ii) Install the following additional Redhat libraries

./ibm-yum.sh install <package> - where packages are:
ksh* 
compat-db* 
compat-libstdc++-33* 
compat-glibc-2* 
openmotif22-2* 
libXtst* 
libXp* 
libXmu* 
libXtst* 
pam* 
rpm-build* 
elfutils* 
libXft* 
gtk2*

iii) WebSphere requirements

a) WAS 8.0.0.5 is the minimum requirement 

b) Additional required WebSphere iFixes (for the Deployment Manager) are:
PM62615 - Here     is     Fix     Central     iFix     for     PM62615   
PM71430 - Here     is     Fix     Central     iFix     for     PM71430   

iv) Synchronise the time on all systems in the deployment by running:  ntpdate clock.redhat.com on each system
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v) Configure the Open File Descriptor limit to at least 8192 on all systems (DM, Node1, Node2 and DB2)

vi /etc/profile
add ulimit -n 8192 

verify by running: ulimit -a
On none windows platforms ensure that the Open File Descriptor limit is set to at least 8192
ulimit -n 8192

vi) Setup a NSF4 Shared Area for the DM, Node1 and Node2
� In a Networked Deployment (multi node clustered environment with several systems) there is the need to set up a shared area 

which all nodes and the DM can access.
� All nodes in the cluster need to have read and write access to this area.
� This is used to store indexes which Connections needs.
� This area needs to be setup prior to the Connections install as the installation will ask for this location during the setup process.

� NOTE:  Its highly recommended to use a 'fast reliable networked file system' for both this shared file area and the server were 
you locate your databases.

When using NFS, use NFS v4 because NFS v3 lacks advanced locking capability. 

In this scenario we will set up the NFS share on our Deployment Manager; then share it out to each Nodes system so that each node 
system can read/write to the share.
These are the steps to do this:

On the DM system (dm&his.spengo.company.com), create a Share folder (using NFS4 Server)
� Create a folder on the system you want to share the folder on eg on the DM system create a folder /opt/IC_Share eg:  mkdir 

/opt/IC_Share
� Give full read/write access to this folder, chmod -R 777 /opt/IC_Share

       With NFS v4 you can export just one file system, so all the folders you need to mount on the clients should be under this one.

Edit the /etc/exports file [ie #vi /etc/exports] and add the following lines
/opt/IC_Share  node1.company.com(rw)
/opt/IC_Share  node2.company.com(rw)

Write and Quit [:wq!]

verify nsf service is running - if it is not then enable it via services
service nfs restart | stop | start
mount -all

You have now shared this folder to systems node1 and node2

Config Node1 and Node2 to access the Shared Folder on the DM system as follows:
Enable the nfs service on node1 and node2

create the folder to mount to eg:   mkdir /opt/IC_Share

Add the following line to 
vi /etc/fstab
dm&ihs.spnego.company.com:/opt/IC_Share   /opt/IC_Share  nfs

Mount the remote file system: mount -all
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3. Middleware installation and configuration

3.1 IBM Installation Manager 1.5.3:
� WebSphere V8.0 is installed using the IBM Installation Manager  (IM) so we must install this first.  You can download IM 

1.5.3 from http://www-01.ibm.com/support/docview.wss?uid=swg24032358.  
� Unzip locally on your machine and run install to begin the IM installation...this will display the following screen.  
� Select Next to continue...

 

� Accept the license agreement and select Next

�
�
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� select Next to continue...

 
�
� At this summary screen select Install to begin the installation...

 
�
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� After some time the installation will complete and you will see:

 
That's the IM installed.  

Note: You will need to do this on your Deployment Manager, Application Server(s), HTTP Server and Plugin's servers in your 
deployment.

Tip: How to start the Installation Manager to install WAS; the IHS webserver and updates:
� Goto the folder: /opt/IBM/InstallationManager/eclipse
Select 'launcher' or from the cmd line enter "./launcher"
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3.2 WebSphere V8.0 Deployment Manager Installation

Create the following folder: /opt/software   - we will use this folder to store all download images required to install WAS DM

Download the WAS Network Deployment V8 install images/zip-files into a folder called /opt/software/WAS80DM on you 
designated DM machine. The four images/zip files to download: 

CZM9KML.zip
CZM9LML.zip 
CZM9MML.zip
CZVG4ML.zip

Unzip all four zip files and you will see the following files in the WAS80DM folder:

 

Startup the Installation Manager, which you installed earlier, on your deployment manager system.

� Select File then Preferences.
� Select the Add Repository... button and enter the details to the path for the DM repository.config file.  Select OK to 

continue...

 
�
� Now select Install
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� Accept the license agreement and next to continue...

 
� select Next to continue...

�

� Enter the path to were to install the deployment manager.  Select Next to continue...
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�

 

• Select Next to continue...
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� The installation packages are then displayed to you.  I did not change any of the defaults here.  Select Next to continue...

 

� Finally a summary screen will be displayed.  Select Install..
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� After some time the installation will complete.  During the installation you will see stuff like this...

 
�
� Once complete you are asked to create a Deployment Manager Profile... Select Profile Management Tool to create a 

profile and then Finish. 
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• The WebSphere Customization Toolbox starts.  Select the Create... button

 
�
� Change the WebSphere Application Server selection to Management and then Next

 
�
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� Select the Deployment manager option and then Next to continue...

 
�
� Select the Typical profile creation option and then Next to continue...

 
�
�
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� Ensure Enable administrative security is checked and enter an admin user name & password.
� Select Next to continue...

 
�
� At this summary screen select Create (to create the profile)...this will take a few minutes...

 
�
�
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� Check the option Launch the First steps console and then select Finish.

 

� Select the Installation verification option

 
�
� Once complete you should see the following messages...
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�
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� Using your Browser check that you login to Websphere Integrated Solutions Console (also known as the WAS Admin 
Console) via the URL address: "https://dm&ihs.spnego.company.com:9043/ibm/console/logon.jsp" using the administrator 
user & password define previously; in this case that admin user is "wasadmin".

 

Your Deployment Manager is now setup.
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3.3 Install WAS V8 Applications Server on Node1 and Node2
�

� In this scenario we have a 2 node cluster deployment so we will repeat these steps on both Node1 and Node2 systems.
�
� Download and unzip the following four WAS V8 images/zip files into the folder /opt/software/WAS80App

CZM9HML.zip
CZM9IML.zip
CZM9JML.zip
CZVG3ML.zip

�
� After unzipping these files you should see the following files/folder in the WAS80App folder:

 
�
� Start Installation Manager which you installed earlier.
� Select File and Preferences to add the installation repository for the AppServer install.  
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� Select the Add Repository... button and enter the details to the path for the repository.config file.  Select OK to continue...

 

� Now select Install from the main window on the installation manager. 
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� Accept the license agreement and Next to continue...

 
�
�
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� Enter the Installation directory. Select Next to continue...

 
�
� Select Next to continue...

 
�
�
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� The Install Packages screen is displayed.  I did not change any of the defaults here.  Select Next to continue...

 
�
�
� The summary screen appears.... Select Install to start the installation process...

 
�
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�
� After a few minutes the install will complete and you will see the following screen. 
� Select the option Profile Management Tool to create a profile and then Finish. 

 
�
�
� This will startup the WebSphere Customization Toolbox.  Select the Create... button

 
�
�
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� Select Application server and then Next to continue...

 
�
� Select Typical profile creation and then Next to continue...

 
�

© Copyright IBM Corp. 2013 28



� Ensure the Enable administrative security box is checked and enter a User name and Password for the WAS Admin.
� I use the same User name and password that I used when setting up the Deployment Manager ie "wasadmin"
� Select Next to continue

 
�
� The summary screen is displayed.  Select Create to create the profile...
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�
� This may take a few minutes to complete.
� Ensure the Launch the First steps console option is selected; then click on Finish

 
�
� Select Installation verification

 
�
� Once complete you should see the following messages with the final message being: The installation verification is 

complete.

 

• You have now competed the setup of the Application Server on Node1.
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•
• Redo these steps on Node2.
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3.4 Install IBM HTTP Server (IHS) V8

NOTE: In this scenario we install the HTTP Server on the same machine as the DM

Download the following WAS Supplemental images/zip files into the folder /opt/software/WAS80Sup on your IHS system; 
the four image/zip files are:

CZM91ML.zip
CZM94ML.zip
CZM95ML.zip
CZXR9ML.zip

�
� Unzip these zip files in the WAS80Sup folder and you should see following folders/files:

 
�
� Start the Installation Manager which you should have installed earlier.
�
� Select File then Preferences and in the Preference dialog select Add Repository...

 
�
� Select the Add Repository... button and enter the details to the path for the Supplementary repository.config file. 

Select OK to continue...
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From the Installation Manager main window select Install.  This will pickup that the HTTP Server, Plugins and Toolbox is now to be 
installed.  

Select the following three options (as in the next screen shot):
1. IBM HTTPServer for WAS
2. Web Server Plug-ins for IBM WAS
3. WebSphere Customization Toolbox

� Do NOT select Application Client for IBM WAS
�
� Select Next to continue...

 
�
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� Accept the license agreement and Next to continue...

 
�

� Specify the path for each install item.  I used the default paths for each.  Select Next to continue.

 
�
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�
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� Select the features to install (as seen below) and Next to continue...

 

� Enter the port you want HTTP to run on (typically port 80) and Next to continue...

 
�
�
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� At this summary screen select Install to start the installation process...

 
�
� After a few moments the following screen will appear:
� Now configure the HTTP Server; select Webphere Customization Toolbox and then Finish.

 
�
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� Select Web Server Plug-ins Configuration Tool and then select Launch Selected Tool

 
�

� select Add...

 
�
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� Enter the name of the HTTP Server and the location to were your plugins were installed earlier. Select Finish to continue

 

Select Create... for the Web Server Plug-in Configuration
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� Select the type of HTTP Server which is IBM HTTP Server V8. Select Next to continue...

 
�
�
� selected 64 bit, then Next to continue...

 
�
�
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� Specify the location of the httpd.conf file and  set Web server port=80 and then Next to continue

 
�
� Specify the IHS Admin UserID=ishadmin and Password; then Next to continue

 
�
�
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� Specify the UserID=ihsadmin, and Group=ihsadmins, then Next to continue

 
�
� Give your web server a definition name. Select Next to continue...

 

� Under Configuration scenario select "(Remote) Host name or IP address for the application server" and enter the 
full DNS name for your HTTP server.  Select Next to continue...

 
�
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� Finally the Summary screen; select Configure to configure the IBM HTTP Server.

 

� Once complete you should see the following... Select Finish to close the wizard.
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3.5 Update DM, Applications Server and IHS to required Fixpack and iFixes

IBM Connections V4.5 requires the following WAS updated:
1. WAS V8 Fixpack V8.0.0.5
2. Additional WAS V8 iFixes; they are:

• PM62615   - Here     is     Fix     Central     iFix     for     PM62615   

• PM71430   - Here     is     Fix     Central     iFix     for     PM71430   

�
�
___1. How to update your WAS V8 environment to V8.0.0.5

Repeat these Steps for each of the following system: DM, WAS(Application Servers) and the IHS system
� Stop all servers (DM, WAS, IHS) before installing the fixpacks
� Launch the Installation Manager and select the Update link... and on the next screen select the Update all check box; You 

may be requested to enter your IBM registered credentials at this point.
� Note: The next screen shown is an example of what you would see if the DM, Application server and IHS co-existed on the 

same machine
� Select Next to continue
�

 
�

� Validation and preparation checks will then happen and after a few minutes you will get this next screen. 
� Accept the licence agreement and then select Next to continue...
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�
�
� The update installer will now collect the files needed to do the update/install; this will take a few minutes... 
� Once completed, select the Update button.  This will update your server to the latest fixpack for WAS 8.0 which is (at the 

time of writing) ie V8.0.0.5.  
� Note: IBM Connections V4.5 at release requires WAS V8 fix pack 8.0.0.5.  At the time of writing this was the latest fixpack 

available. Please check with IBM Connections V4.5 documentation for support for later releases of WAS fixpacks.
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�
� After several minutes the update will complete returning the following screen. Now select Finish to exit the Update 

installer.

 

You have now updated to V8.0.0.5
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___2. Additional WAS V8 iFixes required to support IBM Connections V4.5
. 
There are additional iFixes that are required to be installed for IBM Connections V4.5, and these are installed on the Deployment 
manager; they are:

• PM62615   - Here     is     Fix     Central     iFix     for     PM62615   

• PM71430   - Here     is     Fix     Central     iFix     for     PM71430   

Steps - on the DM system do the following:
� download the iFixes into separate folders and unzip them
� Load Installation  Manager and select Files, then Repositories
� Deselect all exisitng Repositories; if any such exist
� For each iFix select Add Repositories and navigate to the folder where the iFix was unzipped and select it's corresponding 

repository.config file as in the example screen shot below:
� Select the locations of the iFixes and then Test Connections to verify
� Deselect the option Search service repositories during installation and updates and select the Apply button
� Select OK to continue.

 

� Select Update to continue
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� Select IBM WAS Network Deployment Manager (as in the screen shot below).. Select Next to continue

 

� Select both iFixes, then Next to continue
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� Select Update to install the iFixes

 

� And after a few minutes the install will complete.   
� Select Finish to return to the Main screen; then File > Exit to exit the Installation Manager.
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3.6 Install DB2 10-FP1 Server

Install Steps for DB2
� Copy the DB2 V10.1 install/image file to your machine.  
� Uncompress the files; then, as root, start the DB2 installer by running ./db2setup.  You will see:
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� Select Install a Product... and then under DB2 Enterprise Server Edition Version 10.1 select Install New

 
                

� click Next to continue

       
�
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� Accept the license agreement... and Next to continue...

        
�
� Select Typical and then Next to continue...
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� Select the Install DB2 Enterprise Server Edition Version on this computer then Next to continue

 

                

� Used the default path for the Directory; select Next to continue
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Use the default names and directory paths and enter a valid password. Select Next to continue. 

 
               

�
� Select Create a DB2 instance...  select Next to continue...
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� Select Single partition instance...  select Next to continue...

 
                
       
� Enter your DB2 instance owner and password; used the default names, and entered a valid password.  
� Select Next to continue.

 
�
�
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� Enter your fenced username and password... I used the default user names... select Next to continue.

 
                  
�
� Select Do not set up your DB2 server to send notifications at this time, then Next to continue.

                
�
�
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� On the Summary screen, check all setting and if OK select Finish to begin installing DB2

 
            

� Installer with start...

        
�
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� After some time the installation will complete...Select Finish to close the installer and you are returned to the cmd prompt.

 
�

Check the version of DB2 installed as follows:
� At the CMD prompt enter the following commands to verify the version of DB2 installed.

su - db2inst1
db2level

 

Apply the DB2 License:
� Out of the box DB2 comes without a license installed. To check this run the cmd db2licm -l

 
� The License type is reported as "License not unregistered"
�
� Copy the DB2 license to the DB2 system and install the license by running the cmd db2licm -a <database license file> 

e.g.

 

� Verify that the license in installed correctly by re-running the cmd db2licm -l
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Copy the DB2 JDBC jars files to the DM and to each of the Application Nodes

� On the DM, Node1 and Node1 create the folder: /opt/DB2-JDBC-jars and copy the following DB2 files (from 
/opt/ibm/db2/V10.1/java) to this folder on the DM/Node1 & node2 system

�
� Note: These files must be in exactly the same folder on the DM and the Application servers/nodes
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3.7 Install Tivoli Directory Integrator (TDI) V7.1 + Fixpack 5

IBM Tivoli Directory Integrator 7.1 Install:
The install of TDI is needed so the IBM Connections profiles database (PEOPLEDB) can be populated with LDAP information.

In this scenario the TDI will be installed on the same system as the DB2.

NOTE: The TDI V7.1 Installer (launchpad.sh) required the Firefox browser version 3.0.18 to run it's install. You can download and 
install FF 3.0.18 as follows:

� download firefox-3.0.18 (from: https://ftp.mozilla.org/pub/mozilla.org/firefox/releases/3.0.18/linux-i686/en-US/ ) into the 
folder: /opt/software/firefox3.

� decompress firefox-3.0.18.tar.bz2 using the cmd: tar -jxvf firefox-3.0.18.tar.bz2  -- Firefox is then extracted into the 
folder: /opt/software/firefox3/firefox

� set the following Environment Variable: export BROWSER=/opt/software/firefox3/firefox/firefox

Installing TDI V7.1
� Copy the TDI V7.1  installer image (CZ9MNML.tar) to your machine (/opt/software/TDI71) and decompress it.  
� Start the TDI V7.1 launchpad by running:  ./launchpad.sh...  and then follow these instructions.

� Select Install IBM Tivoli Directory Integrator and then Tivoli Directory Integrator 7.1 Installer.
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� Select English and click OK

 

� Select Next from the Introduction screen...
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� select Next

� Accept the terms of the license agreement and select Next

 

© Copyright IBM Corp. 2013 65



� Keep the default install path...  select Next

 

� Select Typical as the Install Set; then select Next
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� Select Do no specify - use current working directory at startup time and then Next

 

� Use the default ports and select Next
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� Do not select Register as a system service, then click Next

 
�
� Accept the default port values for the Integrated Solutions Console Port Values, then select Next
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� Do not select Register as a system service, then click Next

 

� Please wait a few moments for TDI to configure
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� A Pre-Installation Summary screen will display...  select Install to start the installation...

 

� Installing begins...this will take a few minutes...
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� The Install Complete screen will next appear.  Deselect the option to Start Configuration Editor; then select Done

 
You can now Exit the installer... TDI 7.1 is now installed, but now we need to install FixPack 5.

�
�

IBM Tivoli Directory Integrator 7.1 FixPack 5 Install
� Copy TDI V7.1 Fixpack 5 (7.1.0-TIV-TDI-FP0005.zip) to the folder /opt/software/TDI7.1-FP5 and unZip it.
� Make sure TDI is not running before applying the fixpack.  
� In the 7.1.0-TIV-TDI-FP0005 folder there is a file called applyUpdates.sh; copy this file to /opt/IBM/TDI/V7.1/bin/ 

replacing the version that is already there.
� Goto /opt/IBM/TDI/V7.1/bin and run the following commands:  chmod 755 applyUpdates.sh

Note: Run the following commands from a VNC session

./applyUpdates.sh -update /opt/software/TDI7.1-FP5/7.1.0-TIV-TDI-FP0005/TDI-7.1-FP0005.zip

� The FixPack will then install.

 

�
� To check the install was OK run ./applyUpdates.sh -queryreg it should report that FP5 is installed...
�
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4. Deployment configuration steps

4.1 Enable Security on the Deployment Manager
Next we need to add the LDAP repository to your Configuration...

� Login to your WAS admin console -> https://dm&ihs.spnego.company.com:9043/ibm/console (use wasadmin user and 
password).

     Enable the following General Settings:
� Select: Security -> Global security.  
� Ensure the Enable administrative security and Enable application security are selected.  
� Under User account repository ensure Available realm definitions is set to Federated repositories
� Select Apply and Save.

 
�
�
�
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Select: Security -> Global security -> Web and SIP Security -> General Settings.  
� Ensure the Use available authentication data when an unprotected URI is accessed check box is ticked.
� Select Apply and Save.

 
�
�
Select: Security -> Global security -> Web and SIP Security -> Single sign-on (SSO).  
� Enter the Domain name - you must prefix it with the dot/period (.) e.g.  ".spnego.company.com"
� Ensure the Interoperability mode is select and enter the domain name.
� Ensure the LTPA V1 and V2 Cookie names are spelt and cased correctly as shown ie use  "LtpaToken" and "LtpaToken2"
� Ensure Web inbound security attribute propagation is checked
� Ensure Set security cookies to HTTPOnly to help prevent cross-site scripting attacks is checked
� Select Apply and Save.

 
�
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Configure the Federate LDAP Repositories:

� Select: Security -> Global security -> Configure... opposite Federated repositories
� Select Add Base entry to Realm...

 

• Then select Add Repository... and then LDAP repository

 
�
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Enter the Repository information as shown below; then OK, then Save

 

�
� Enter the base entry...  select OK, then Save

 

Now, restart the Deployment Manager and the Node Agents.
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Add an LDAP user as an administrator:
� Login to your admin console -> https://dm&ihs.spnego.company.com:9043/ibm/console 
� Select Users and Groups -> Administrative user roles; select Add...

 
� select Administrator under Role(s); search for the user: AdminFromLDAP and add that user to Mapped to role. Select 

OK; then Save.

 

 

Verification check
� Logout of the WAS Console
� Now relogin as the user AdminFromLDAP. If all went well then you should log in successfully. 
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4.2 Federate Application Server into Deployment Manager:

Next we federate the AppServers (Nodes) into the Deployment Manager.  
Checks:
i) Ensure the clocks are in synch between your DM and AppServer.  Run ntpdate clock.redhat.com to on your DM and AppServer.
ii) Make sure the DM is started and the AppServers are stopped.

Steps: On each of your Application Servers (Nodes) execute the following:

cd /opt/IBM/WebSphere/AppServer/bin
./addNode.sh dubxpcvm603.mul.ie.ibm.com 8879 -user wasadmin -password wasadmin

You should see the following

 

Verify the federation has been successful by:
� Logging into your DM via: https://dm&ihs.spnego.company.com:9043/ibm/console
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� Then goto Servers / Server Types / WebSphere Application Servers you should see something like this...

 

Repeat this for each node in your deployment.
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4.3 Configure HTTP server to accept SSL connections

___1. Create Self-Signed SSL Certs for HTTP Server:
Connections supports login only over SSL, so we need to configure the HTTP server to accept SSL connections.

� Startup ikeyman. This should be located under the HTTPServer/bin folder.

 
� Select Key Database File -> New.  Give the key a name, I usually call it the name of the server running the HTTP Server 

and I usually store it under the HTTP Server Plugin definition/..

 
�
�
� On selecting OK you will be asked to enter a password and make sure to select the Stash password to a file check box.

 
�
�
� You are returned to the ikeyman panel with the dubxpcvm766.kdb opened.  Now select Create and New Self-Signed 

Certificate...
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Give the Key Label a name, and set the field Common Name to the IHS hostname.

 
�

Once you select OK you are returned to ikeyman

 
� Thats the certificate configured.  We now need to configure the HTTP Server to use this certificate.
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___2. Configure httpd.conf to enable SSL:
In httpd.conf file which is under /opt/IBM/HTTPServer/conf, add the following lines to the end of file before the LoadModule 
was_ap22_module and WebSpherePluginConfig sections...

LoadModule ibm_ssl_module modules/mod_ibm_ssl.so
<IfModule mod_ibm_ssl.c>

Listen 0.0.0.0:443
ServerName dm&ihs.mul.ie.ibm.com
<VirtualHost *:443>

SSLEnable

AllowEncodedSlashes On

</VirtualHost>
</IfModule>
SSLDisable

Keyfile "/opt/ihs/key.kdb"
SSLStashFile "/opt/ihs/key.sth"

___3. Verify IHS is SSL enabled
� Restart/start IHS and the IHS administrator as follows: from the folder /opt/IBM/HTTPServer/bin enter: 

./adminctl -k restart | start | stop

./apachectl -k restart | start | stop

� Enter the IHS server URL (using the https protocol) i.e. https://dm&ihs.spnego.company.com, in to your browser's address box 
and you get:
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Click Add Exceptions... and then click Confirm Security Exception and you see:
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5. Create Connections DB2 databases using the dbWizard

___1. Log in, using a VNC client, to your database server as the root user or system administrator.

___2. Grant display authority to all users by running the following commands under the root user or system administrator:
     xhost + // Grant display authority to other users
     echo $DISPLAY // Echo the value of DISPLAY under the root user

___3. Switch to the db2 instance admin (in this case the db2 admin is db2inst1)
     su - db2inst1

___4. export the DISPLAY; enter:   export DISPLAY=:1.0

___5. Start the Database Instance, by entering:  db2start

___6. As root, download IBM_Connections_4.5_wizards_lin_aix.tar to your DB2 system and untar it (I downloaded this file into 
a folder called /opt/software/ic45)
�

Note: The dbWizard must be run using the DB2 instance user (in this scenario this user is db2inst1)

___7. Assign the DB2 instance user as the owner for the file IBM_Connections_4.5_wizards_lin_aix.tar & it 's respective 
folders.

cd /opt/software
chown db2inst1:db2iadm1 -R IC45/
cd /opt/software/ic45 and enter 'ls -la' and you should see the file IBM_Connections_4.5_wizards_lin_aix.tar has the 

owner db2inst1:db2iadm1 i.e:
       -rw-r--r--  1 db2inst1 db2iadm1 580044800 Apr 22 10:19 IBM_Connections_4.5_wizards_lin_aix.tar

___8. As db2inst1, run ./dbWizard.sh , from the folder /opt/software/ic45/Wizards, and follow these screens:
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� Slect Next to continue

     
�
�
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� Select Create and then Next 

 

�
� Select the path for your DB2 database installation location and the database instance name...  select Next to continue...

 
�
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� Ensure all databases are selected and then Next to continue...

            
�
� The summary screen is displayed... review the setting and select Create

            
�
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� Select Execute to begin creating the databases... this will take some time to complete.

            
�
� At this point the databases are being created and you will the screen updating with info like this:
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� After some time (10+ minutes) the following screen appears:
� Check for each database that the Result: message is The database creation was successful.
� Select Finish to end the install.

 

�
Verify that all databases are created successfully by doing the following:
� In the final screen (above) check for each database that the “Result:” message is “The database creation was 

successful.”
� Check the log files for any issues.
� As user db2inst1 entering the following DB2 command and verify all Connections' databases are listed:

db2 list database directory 

� Now, as user db2inst1, issue the following DB2 command to set the default for the number of concurrently open DB2 
databases to 18:  

db2 update dbm cfg using numdb 18 
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6. Populate the Connections profiles (PEOPLEDB) database with LDAP User Information

� On the DB2 server, as root, go to the /Wizard folder and enter ./populationWizard.sh
� The first screen is the Welcome screen; select Next to continue

 
�

� Select DB2 Univeral Database and click Next...... 
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� Next enter the database information for the profiles (PEOPLEDB) database; select Next to continue..

 

� Enter the LDAP server name and port number and then select Next to continue...
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� Enter the bind user details and password  CN=bind,OU=branch,DC=spnego,DC=company,DC=com

 
         

� Enter the search base and search filter...  select Next to continue...
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� Use the default database mappings...  select Next to continue...

   

� Do not select any of  the Optional database tasks
� Select 'Yes' for Do you want to run the task that marks the profiles of each manager?
� select Next to continue...
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� Review the Summary page to ensure that the information you entered in the previous panels is correct. 
� To make changes, click Back to return to the relevant page and edit the information.  Otherwise, click Configure to begin 

populating the database.

 

The next screen indicating that Execution of the Population Task is in progress... the population process could take over one hour.
Installing IC45 does not require the profiles (PEOPLEDB) database to be populated so I will turn to installing IC45 now and return to 
this in one or two hours time to complete the final steps.
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� Once the population wizard has completed you should get the screen below.
� WARNING: There are over 400k users in my LDAP branch but the message below says that it has only successfully populated 

the first 20k user... this is a limitation of the dbPopulation Wizard; I will need to populate the remaining users manually (see 
below).

� Select Finish to exit the wizard.

 

How to complete the population of the profiles database (PEOPLEDB) with the full 400K users MANUALLY
NOTE! The  ./populationWizard.sh wizard stopped populating after the first 20k users. To fix this issue I need to 
manually populate the remaining 400k users using the following steps:

1. From a CMD line change to the folder: /opt/software/IC45/Wizards/TDIPopulation/linux/TDI

2. Edit the file profiles_tdi.properties and change the value for source_ldap_page_size=1000 then save the file.

2. Run the following command:  ./collect_dns.sh    - Note: this took a few hours to complete.

3. Make a backup copy of this newly created file collect.dns   i.e. cp collect.dns backup-collect.dns 

4. Split the file collect.dns into chunks of 20k users by running:
split -l 20000 collect.dns collect-split

enter ls -la collect-split* and you can see the list of files created each with 20k users; in my case the following files were 
created:
collect-splitaa collect-splitab collect-splitac collect-splitad collect-splitae collect-splitaf collect-splitag collect-splitah collect-splitai 
collect-splitaj collect-splitak collect-splital collect-splitam collect-splitan collect-splitao collect-splitap collect-splitaq collect-splitar 
collect-splitas collect-splitat

5. Populated the profiles database by running the following command
for i in collect-splitaa collect-splitab collect-splitac collect-splitad collect-splitae collect-splitaf collect-splitag collect-splitah 
collect-splitai collect-splitaj collect-splitak collect-splital collect-splitam collect-splitan collect-splitao collect-splitap collect-splitaq 
collect-splitar collect-splitas collect-splitat ; do cp $i collect.dns ; ./populate_from_dn_file.sh $i ; rm -rf collect.dns ; 
done 

� Note: this step took over 24hrs to run to completion and ended with the profiles db populated with all 400+K users.
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7. Installation of IBM Connections 4.5 (IC45) :
� IC45 is installed over WAS 8.0.0.5.
� The install of IC45 is done on the Deployment Manager (DM) machine and then synchronised with the nodes.

Check that the:
1. DM and Nodes are stopped.
2. All directory paths that you created contain no spaces. 
3. Open File Descriptor limit is 8192. (ulimit -n 8192).
4. required OS libraries/patches are installed on all systems

Steps: 
� Copy the IC45 install file (IBM_Connections_4.5_lin_aix.tar) to your Deployment Manager and decompress it.
� Start the IBM Installation Manager: got to the folder: /opt/IBM/InstallationManager/eclipse and start ./launcher
� In the IM specify the IC45 repository file.
� Select Install to start the IC45 install and follows these screen

� Select Version 4.5.0.0

 

              

� In the next screen select Accept the license agreement; then click Ne

 

�  
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� Specify the Installation Directory and Next to continue... 
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� Select what applications to install.
� I selected Metrics because when I get to the Cognos install screen I can choose Not to Install Now and do this later.

� I did NOT select IBM Connections Content Manager (Filene

 

Note: IBM Connections Content Manager is not selected...
�
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� Select the path to the WebSphere Application Server instance running on your deployment manager.
� Enter the hostname, 
� NOTE: the Administration user ID =AdminFromLDAP
� Select the Validate button at the bottom.

 

The install will then proceed to perform varius checks and retrieve info from the DM. After a few moments you should get the 
prompt: Validation successful.
Select OK, then Next to continue.
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� Selected the Medium topology
� Select the Nodes as required (I selected all nodes)   then Next

 

 
�
�
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� Configure Database - (the database server must be started) as shown below; click Validate; then Next
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Next is Cognos - select Do later

 

Next Content Store
Enter the network share location (that will be shared with the Application servers Node1 & Node2)
Enter the local content store; then Validate; then Next
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For Notifications I selected None as I will configure that later.

 
�

And finally the summary screen.... click Install to begin the install of IC45. This may take over an hour to complete.

                
�
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� Once the install is complete you'll see:  

               
�

                   
� Select Finish to exit and return to the Installation Manager, then select File -> Exit
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8. Post Install steps

8.1 Copying Search conversion tools to local nodes

___1. On each Applications server (node) copy the entire stellent folder in the shared drive (under /opt/IC_Share/search) to 
the local search folder under /opt/IBM/Connections/data/local.

___2. Via the WAS console update the  Websphere variable: FILE_CONTENT_CONVERSION to point to the exporter file in the 
stellent folder on local drive of each node (that you copied in step 1)
set the variable: 
FILE_CONTENT_CONVERSION=/opt/IBM/Connections/data/local/search/stellent/dcs/oiexport/exporter

___3. Edit the file setupCmdLine.sh and add the following export statements

vi /opt/IBM/WebSphere/AppServer/bin/setupCmdLine.sh
add

export PATH=$PATH:/opt/IBM/Connections/data/local/search/stellent/dcs/oiexport
export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/IBM/Connections/data/local/search/stellent/dcs/oiexport

___4. Add the following export statements to the /etc/profile file

export PATH=$PATH:/opt/IBM/Connections/data/local/search/stellent/dcs/oiexport
export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/IBM/Connections/data/local/search/stellent/dcs/oiexport
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8.2 Configuring the HTTP Server

___1) Add the Wed server as an unmanaged node AND Add Web server as a server
A quick way to do this is to use the special configure file that was created when the IHS was created as follows:
From the IHS server, copy the file /opt/IBM/WebSphere/Plugins/bin/configurewebserver1.sh (remember I used the name 
'webserver1' when creating the IHS server) to the Deployment Manger system in to the folder: 
/opt/IBM/WebSphere/AppServer/bin

NOTE: The above filename and location will vary depending on what values you used to install the IHS and the Deployment Manager

On the DM machines run the configurewebserver1.sh file as follows
cd /opt/IBM/WebSphere/AppServer/bin
./configurewebserver1.sh

You will be prompted to enter WAS credentials and then after a few minutes the creation of the Web server will complete...you 
should see the following messages appear:

 
And end with...

.  
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� Stops and restart the Deployment Manager
� Log in to the WAS console and verify that the Web server has been added under Servers -> Server Types -> Web servers 

and you should see:
� Try Stop and Start the web server thru the menu options. 

 

Note: The IHS administrator must be running in order to be able to administrate the web server via this Web server panel and to to 
synchronize configuration files between the HTTP Server and the DM.  To do this navigate to ../HTTPServer/bin directory (on the 
IHS server) and issue the command: ./adminctl -k start
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___2) Generate and Propagate configuration info to the Plugin-cfg.xml file 

� Return to Servers - Server Types - Web Servers. 
� Select the check box beside webserver1 and click the Generate Plug-in button.

 

results in...

 

� Select the check box again and click Propagate Plug-in (which propagates the plugin-cfg.xml file to the webserver)
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___3) Propagate The plug-in keyring file from the DM to the IHS web server

� Click on webserver1 then click on the link: Plug-in properties

 

� click on Copy to Web server key store directory

 

The following message is displayed to indicate the successful copying of these keys. Once again, restart the webserver for the plug-
in changes to take effect.
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___4) Adding Certificates to the WebSphere Trust Store

� On the WebSphere Administration Console go to Security > SSL Certificate and Key Management. > Key stores and 
certificates

� Click CellDefaultTrustStore

 

� From within CellDefaultTrustStore, click the Signer certificates link from the right hand side

 

� To add the webservers signer to the trust store, click the Retrieve from Port button.
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� Enter the hostname of the webserver and its SSL port (typically 443) and an Alias
� Click the Retrieve signer information button, which retrieves the information shown at the bottom of the screenshot. 
� Click OK to add this certificate to the list of signers.
� click Save to save this change.

 

results in:
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___5) Update Web addresses used by IBM Connections to access content

Using the wsadmin client, check out the LotusConnections-config.xml (aka lcc.xml) to a temporary directory. From this directory, 
this file must be edited so that all href and ssl_href values are updated to reflect the hostname of the HTTP Server and do not 
include any port numbers.
The file  LotusConnections-config.xml is located in the folder:  LotusConnections-config   i.e.
/opt/IBM/WebSphere/DeploymentManager/profiles/Dmgr01/config/cells/dubxpcvm603Cell01/LotusConnections-config

An example of what needs to be done is as follows

 

� For each Connections applications remove the  ":"+port_numbers of the two 'href' entries and also the 'ssl_href' entry

 
.
Tip: search on "connections.example.com:"   and remove the colon (:) and the port number. Once finished you should not be able to 
find any more occurrences of this string "connections.example.com:" (not the colon at the end of the string; this is most important)

� Save the file and check the file back in using the wsadmin client. After the file is checked back in, resynchronize the node so 
that this change is pushed out.

�
This completes the webserver, SSL, and certificate configuration for this scenario. Now, when the application is started it can be 
accessed at http://connections.example.com/<component, where <component represents any of the Connections applications.

The commands to check-out/ check-in the lcc.xml file and sync all nodes are as follows:
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8.3 Configuring an Administrator User for Homepage

� Login to your admin console -> http://dm&ihs.spnego.company.com:9060/admin (use wasadmin user and 
password).

� Select Application -> Application Types -> WebSphere Enterprise Applications and then select the 
Homepage app.

� Select the Security role to user/group mapping link...  
� Select the admin role and then the Map Users... button.
� Search for the user, AdminFromLDAP in my example, and add them.
� Select OK then Save... the result should be:
�

 

� Synchronise your changes with the other nodes.
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8.4 Enabling Fast Downloads for Files and Wikis

NOTE: Although this is an optional step for customers we do this for all our test systems.

___a) On the Deployment Manager copy the file: mod_ibm_local_redirect.so from 
/opt/IBM/Connections/plugins/ihs/mod_ibm_local_redirect/linux_x64-ap22/
to the IHS system in to the folder: /opt/IBM/HTTPServer/modules/

cp /opt/IBM/Connections/plugins/ihs/mod_ibm_local_redirect/linux_x64-ap22/mod_ibm_local_redirect.so 
/opt/IBM/HTTPServer/modules/

___b) Edit the httpd.conf (/opt/IBM/HTTPServer/conf) and add/edit the following:

vi /opt/IBM/HTTPServer/conf/httpd.conf

LoadModule ibm_local_redirect_module modules/mod_ibm_local_redirect.so // had to add this
LoadModule env_module modules/mod_env.so // already existed

___c) Add the following to the bottom of the httpd.conf file...  [node: paths will need to change based on installation]

Alias /downloadfiles /opt/IC_Share/files/upload/
Alias /downloadwikis /opt/IC_Share/wikis/upload/
<Directory /opt/IC_Share/files/upload/>
Order Deny,Allow
Deny from all
Allow from env=REDIRECT_FILES_CONTENT
</Directory>
<Directory /opt/IC_Share/wikis/upload/>
 Order Deny,Allow
Deny from all
 Allow from env=REDIRECT_WIKIS_CONTENT
</Directory>
<Location /files>
 IBMLocalRedirect On
 IBMLocalRedirectKeepHeaders X-LConn-Auth,Cache-Control,Content-Type,Content-Disposition,Last-Modified,ETag,Content-

Language,Set-Cookie
 SetEnv FILES_CONTENT true
</Location>
<Location /wikis>
 IBMLocalRedirect On
 IBMLocalRedirectKeepHeadErs X-LConn-Auth,Cache-Control,Content-Type,Content-Disposition,Last-Modified,ETag,Content-

Language,Set-Cookie
 SetEnv WIKIS_CONTENT true
</Location>

___d) On the Deployment Manager edit the files-config.xml and wikis-config.xml files that can be found in the 
folder:/opt/IBM/WebSphere/AppServer/profiles/Dmgr01/config/cells/dslvm171Cell01/LotusConnections-config/ and 
make the following changes:

files-config: search for "<download>" and set the values of the properties to those shown in blue
<download>

<modIBMLocalRedirect enabled="true"
hrefPathPrefix="/downloadfiles" />

<stats>
<logging enabled="true" />

</stats>
</download>

wikis-config.xml: search for "<download>" and set the values of the properties to those shown in blue
<download>

<modIBMLocalRedirect enabled="true"
hrefPathPrefix="/downloadwikis" />

<stats>
<logging enabled="false" />

</stats>
</download>

___e) Synchronize and Restart IBM Connections as follows:
� Do a Full Synchronize on all Nodes
� Stop all Connection's clusters
� Stop and reStart the Deployment manager
� Stop and Restart the HTTP server 
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� Start all Connections Clusters
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8.5 Configure Notifications

Machine Hostname Applications Version# OS/version
dm&ihs.spnego.company.com � WAS Deployment Manager

� IBM HTTP Server (IHS)

WAS v8.0.0.5
IHS v8.0.0.5

RedHat 6 (64bit)

domino.company.com � Domino Mail-in server Domino 8.5.3 Win2008 R2 EE Server

You can configure Notifications by following these steps:
1. In the Domino Mailin server, create a special  ReplyTo user 
2. (In Domino) Configure the ReplyTo user for Notifications
3. (In Domino) Configuring Domino for email notification replies
4. (In Connections DM) Configuring WAS DM for email notification replies
5. (In Connections) Configure news-config.xml for notification replies
6. (in Connections) Sync and restart Connections

___1. Create a special  ReplyTo user and configure

� Open the Domino Admin client, and connect to Domino mail server
� Select People & Group view, click People tab on the right panel.
� Click Register, input the certifier's password for the Domino server.
� Check the Advanced box and createn a ReplyTo user as follows:
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• The Internet Domain value could be set to the real domain you use:

 
Click Register to complete the registration.
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___2. Now, configure the ReplyTo user For Notifications

Go back to People & Groups tab, expand People byOrganization.
Edit the account of the user used to direct reply mail (the ReplyTo user)

 

� Click Open Mail File for the ReplyTo user.
� Select the View > Agents menu item.

 
�
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� Click New Agent.

 

set the Name field to "replyto"

 

Add the following Lotusscript code to the agent:

Sub Initialize
    
    Dim session As New NotesSession
    Dim db As NotesDatabase
    Dim view As NotesView
    Dim doc As NotesDocument
    
    Set db = session.CurrentDatabase
    Set view = db.getView("$Sent")
    
    Set doc = view.GetFirstDocument()
    While Not(doc Is Nothing)
        Call doc.PutInFolder("$inbox")
        Set doc = view.GetNextDocument(doc)
    Wend
    
End Sub
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�
� Save your changes.

 

Open the agent again to set the following properties:
� in the Options section select Shared.
� in the Runtime section select On schedule, and then select More than once a day.
� in the Target field select All new & modified documents.
� select Schedule... and set a schedule to run every 5 minutes, all day.
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___3. Configuring Domino for email notification replies

� Open Domino Admin client and click on configuration tab.
� Expand Messaging in the navigator panel, and then click Configuration.

 

� Select the messaging server record and click Edit Configuration.
� Click the Router/SMTP tab, then the Restrictions and Controls tab, and then the Rules tab...then click New Rule...

 

� create a rule that moves emails that have the string "lcreplyto_ " in the To field to the mailbox as follows

 

• Save and Close.
• Stop and Restart the Domino server
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___4. In Connections DM, configuring Notifications
�
_____4.1 Create and configure the mail session: "lcnotifications"

� login to the WAS Console:  https://dm&ihs.spnego.company.com:9043/ibm/console
� select Resources > Mail >  Mail Sessions

 

� Select Scope = Cell=XXXXCell01, then select New...

 

© Copyright IBM Corp. 2013 122

https://dslvm171.mul.ie.ibm.com:9043/ibm/console/navigatorCmd.do?forwardName=MailSession.content.main&WSC=true


� Enter the following information... then OK, then Save
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� select Mail Sessions > lcnotification > Custom properties
� create/verify the following settings:
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_____4.2 Create and configuring the Mail Session: "lcreplyto"

� select Resources > Mail >  Mail Sessions

 

� Select Scope = Cell=XXXXCell01, then select New...
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Enter the following information... then OK, then Save
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� the end result is:

 

© Copyright IBM Corp. 2013 127



___5. Configure news-config.xml for email notifications

Using wpadmin checkout the file news-config.xml; open the file and search for the section "mailin"  and make the following 
changes in blue:

<mailin enabled="true">
    <replyto enabled="true">
    
    <!-- A special ReplyTo address is added to notifications where

 the user can reply to the notification to respond/comment.
 The domain may be a dedicated domain for connections bound
 mails. Or it could be existing domain, in which case a prefix
 of suffix should be provided also. -->

        <replytoAddressFormat>
            <domain>company.com</domain>
            <!-- A prefix OR suffix (not both) may also be provided. 

This is necessary if an existing domain (with other 
email addresses) is being used.
There is a 28 character limit for the affix. -->

            <!--  
            <affix type="suffix">_lcreplyto</affix>
            <affix type="prefix">lcreplyto_</affix>
            -->

<affix type="prefix">lcreplyto_</affix>   // add this
        </replytoAddressFormat>
    </replyto>
</mailin>

Save the file and check it back-in

___6. Sync and Restart Connections

a) from the WAS console 
� Sync all Nodes
� Stop all Connections Clusters

b) Stop and Restart the Deployment Manager

c) from the WAS console Start all Connections Clusters
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